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[bookmark: _Create_a_new][bookmark: _Toc531705641]Introduction
Welcome to the RiskPolicy.CBA Do’s and Don’ts user guide. 
This user guide is designed to provide instructions for those with Policy Author access in RiskPolicy.CBA. This document covers the Do’s and Don’ts when editing document in RiskPolicy.CBA. 
[bookmark: _Toc531705642]Support
For support on RiskPolicy.CBA as a user please refer to the User Quick Reference Guide.
For support on authoring documents, please refer to the RiskPolicy.CBA User Guide for Authors/Owners. 
If you have any other questions about using RiskPolicy.CBA please contact the Risk Policy Operations team. 
Riskpolicyoperations@cba.com.au


[bookmark: _Toc531705643]Supported/unsupported documents 
Both supported and unsupported Word documents can be copied into RiskPolicy.CBA
How to identify supported Word document 
Supported documents can be identified by the alignment of the text (in a single column) and the formatting styles of the document. 
[image: ]
How to identify unsupported Word documents 
Unsupported documents will have the content aligned in tabular format (2 columns) with heading in the left and content in right along with formatting style of the content.
[image: ]


[bookmark: _Toc531705644]Copy content from a supported and unsupported Word document
Creating HTML from a supported document 
1. Copy your content from Word
2. Click on the page you would like to paste the document in. Select Paste. 
[image: F1]
3. Your content will be pasted into RiskPolicy.CBA. You may need to edit and format the content to ensure that it is displaying correctly. 
[image: ]
A few things to take note of:
· DO not use paste clean or paste plain text because
· The paste plain text option pastes the content from the word document as plain text without any table format as in word. 
· The paste clean option will remove all the styles attached with the content.
· If the word document contains many headings and sub-headings which are collapsible and expandable, use “PASTE CLEAN” to paste the content.
[bookmark: _Toc531705645][bookmark: _Toc531705648]Formatting text in RiskPolicy.CBA
[bookmark: _Toc531705649]Headings 
In this topic, we will cover how to edit and update headings that did not convert from the Word document. 
RiskPolicy.CBA does not support certain custom Word heading styles. Many CBA Word templates currently feature both default and custom heading styles. 
[bookmark: _Toc531705650]Heading styles that are supported 
Default heading styles are supported in RiskPolicy.CBA. See image below for examples of default heading styles. 
[image: ]
To ensure that your headings always convert into heading in RiskPolicy.CBA use the default heading styles available in Word. 
Otherwise set the heading in RiskPolicy.CBA manually by using the font options. 
[bookmark: _Toc531705651]Fonts
In this topic we will cover tips when using fonts in RiskPolicy.CBA.
RiskPolicy.CBA does not support all fonts found in Word. 
[bookmark: _Toc531705652]Fonts that are supported
The following font families are supported in RiskPolicy.CBA.
[image: ]
[bookmark: _Toc531705653]Font size
The font size in RiskPolicy.CBA appears in pixels format (px). The font size in Word appears in the point (pt) unit. If after conversion the font size is not the same you will need to manually update and change the font size using the Format Text tab.
[image: ]
Font colour 
You can change the font colour in RiskPolicy.CBA by using the font colour feature in the Format Text tab. 
[image: ]
[bookmark: _Toc531705654]
Bullets
This next topic will cover how to edit and format bullets inRiskPolicy.CBA. 
[bookmark: _Toc531705655]Single level bullets
RiskPolicy.CBA does not support all the different types of bullet lists in Word. As a result certain single level bullet lists may not always appear the same after document conversion.
[bookmark: _Toc531705656]Single level bullets that are supported 
Only circular bullet styles are supported. When copying from Word to RiskPolicy.CBA all other bullet styles will be converted to circular bullets. 
To ensure that bullet lists always convert correctly in RiskPolicy.CBA only circular bullets should be used in Word (see example below). 
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[bookmark: _Toc531705657]Multi-level bullets 
RiskPolicy.CBA does not support all the types of multi-level bullets available in Word. As a result spacing and width for multi-level bullets may not always appear the same after document conversion.
[bookmark: _Toc531705658]Multi-level bullets that are supported 
Only basic, multi-level bullets with difference in space and size are supported. 
To ensure that multi-level bullets convert correctly in RiskPolicy.CBA only circular multi-level bullets should be used in Word (See example below)
[image: ]


[bookmark: _Toc531705659]Numbering lists
RiskPolicy.CBA does not support all the numbering formats available in Word. As a result, spacing, width & indents for numbering lists may not always appear the same after document conversion.
[bookmark: _Toc531705660]Numbering lists that are supported 
Only basic numbering lists (1, 2, 3 etc.) is supported. 
To ensure that numbered lists convert correctly in RiskPolicy.CBA only basic numbered lists should be used in Word. 
[image: ]


[bookmark: _Toc531705661]Spaces in content 
Copying policy documents from Word to RiskPolicy.CBA can sometimes result in extra white spaces. 
[image: ]
[bookmark: _Toc531705662]Resolving spacing issues
Manually delete the extra spaces using the Delete or Backspace keys on your keyboard. 
[bookmark: _Toc531705663]Special symbols
RiskPolicy.CBA does not support all the special symbols available in Word. As a result some special symbols may not always appear the same after document conversion.
[bookmark: _Toc531705664]Resolving symbol issues 
You will need to take a screenshot of the special symbol you would like to use and upload as an image into RiskPolicy.CBA. 
[bookmark: _Toc531705665]

Tables
Adding a table
1. Place the cursor on the content where you want the table to be created
2. Click on the Insert Tab and select Table>Insert Table>Enter the number of rows and columns as required>Click OK
[image: ]
3. OR you can select the number of rows and columns on the drop-down displayed.
[image: ]
4. The table structure will be created.
[image: ]
Add text to a table
1. Place the cursor on the row /column.
2. Type the text required for the content of the table.
[image: ]
[bookmark: _Toc531705666]Table width
Copying tables Word to RiskPolicy.CBA can sometimes result in content below the table getting shifted to right side of the table. 
[image: ]
[bookmark: _Toc531705667]Resolving table width
Change the width of the table to 100% or as required to move the content under the table. ‘


[bookmark: _Toc531705668]Tables with width exceeding the page width
RiskPolicy.CBA only supports tables which have internal CSS but these tables cannot be resized or modified in anyway. As a result certain tables with bigger width exceeds the content page width after document conversion.
[image: ]
The tables should be created in the Word in such a way that it do not exceed the width of the RiskPolicy.CBA content page. 
[bookmark: _Toc531705669]Adjusting table borders
This topic covers instructions to adjust table borders for when the tables in your HTML document come beyond the page border. 
See below for an example of this scenario. 
[image: ]
In this example, the grey line is page border and the table needs to be within it. See below for instructions on how to complete this:
1. Move your cursor over the table border i.e. the yellow line.
[image: ]
2. Click on the border for the cursor to change to the adjustments markers.
[image: ]
3. Click on Edit Source in the Format navigation tab to open the HTML Source. (Highlighted in yellow in the image below). 
[image: ]


4. Search through the HTML Source by clicking Ctrl + F. 
[image: ]
5. Enter the following in the search box: style="margin: auto auto auto
[image: ]
The search results will be highlighted in yellow. 
[image: ]


6. Select the numbers you see next to the word “auto” with your cursor. (Highlighted in blue in the image below)
[image: ]
7. Type the word auto. This should replace the numbers you selected with the word auto. 
[image: ]
8. Repeat this in all the places you see the phrase: style="margin: auto auto auto in your search results. 
9. Once you have performed this action on all the places, click Ok. You will return to your table. The table should be within the page border. 
[image: ]
Creating accordions
1. Place the cursor on the content where the accordion needs to be added.
2. Click on the arrow in the styles tab of the ribbon to display all the styles.
3. Click on the Accordion Heading style.
4. Enter the title required for the accordion header.
5. Enter the content required for the accordion.
6. Place the cursor at the end of the content for the accordion and click on the accordion-stop style in the styles tab of the ribbon.
7. Once the content is saved, the accordion will be displayed.
Inserting images
1. Copy the Policy Dashboard URL from the browser. In this example we will be using the following URL: http://s011vrpw1171.s4.chp.cba/sites/Policy.CBASIT/oprisk/Pages/TestOperationalRisk.aspx 
2. Copy the text starting from http:// through oprisk/. In this example it would be: http://s011vrpw1171.s4.chp.cba/sites/Policy.CBASIT/oprisk/ 
3. You will need to add the following text to your URL. In this example this would look like: http://s011vrpw1171.s4.chp.cba/sites/Policy.CBASIT/oprisk/_layouts/viewlsts.aspx 
4. Paste the updated URL to the browser and hit enter. You will be redirected to the Site contents Page.
5. Click on the images library.
6. On the Files tab, click on the New Folder
[image: ]
7. Enter the Policy Name and click Save. A folder will be created.
[image: ]
8. Select the folder and then from the Files tab click on Upload Document. 
[image: ]
9. [bookmark: _GoBack]Select the file you would like to upload by clicking on Choose file.
[image: ]
10. Click Ok. 
Scroll down the bottom of the page and click Save. 
[image: ]
On the policy page->place the cursor where the image need to be uploaded
[image: ]
Click on the Insert tab, click on the Picture and select SharePoint.
[image: ]
Go to the specified folder, select the image and click Insert. 
[image: ]
Resizing images
To resize the image, select the image and then use your cursor to change the horizontal and vertical size as required.
Superscripts
RiskPolicy.CBA does not support Superscripts and its references which are available in Word. As a result some superscripts may not always work the same after document conversion.
Superscripts will have to be updated manually. 


[bookmark: _Toc531705670]Adding superscripts
1. Place the cursor where the superscripts need to be added.
2. Enter the number of the superscript.
3. Select the number and click on the superscript icon from the Format Text tab. 
[image: ]
	The superscript will be displayed (see image below). 
[image: ]


[bookmark: _Toc531705671]Adding references for superscripts
1. At the bottom of the page content type “Superscripts References” and click Edit Source.
[image: ]
2. Type the following code in the Edit Source. 
<hr width="33%" size="1" align="left"/>
[image: ]
3. Click Ok. 
4. The horizontal rule will be displayed on the page content. Below the horizontal rule, Type the text (superscripts references) along with the superscript number.
[image: ]
5. Select the superscript reference number and click on superscript icon to display the number as superscript and change the font size of the entire reference to 6pt.
[image: ]


6. The superscripts references is displayed in the content.
[image: ]


[bookmark: _Toc531705646]Hyperlinks
Creating internal reference links within a HTML document 
This topic will cover how to create internal reference links within your policy document. 
1. Click Edit to begin editing the policy. 
2. Go to the section you would like to reference. In this example the Introduction should refer to 1.1 Documents Comprising the Program. So 1.1 Documents Comprising the Program has been selected. 
[image: ]
3. Go to the Insert tab and select Link and then From Address to insert a hyperlink. 
[image: ]
4. Leave the name as is and copy the URL of the page that appears in the Address field. 
[image: ]
5. Click Ok. 
6. Add a name to the Bookmark in the Link tab and copy it by using Ctrl + C. 
[image: ]


7. Go to the section where you want to refer to this. In this example this would be the Introduction. 
[image: ]
8. Go to the Insert tab and select Link and then From Address to insert a hyperlink.
[image: ]


9. Paste the bookmark in the URL. 
[image: ]
10. Click Ok. 
11. Test to see in the link has been set up correctly by going to the Page tab and selecting Preview. Click Ok on the warning message that appears. 
[image: ]
Select Leave this page from the message that appears. 
[image: ]
A new tab will open in your Internet browser so that you can preview to see if the link you created works. In this example click on the Introduction goes to section 1.1 Documents Comprising the Program. If your testing goes well, you can go back to the Document tab to Check In and Publish your document. 
[bookmark: _Toc531705647]Updating internal reference links within a HTML document
This topic will cover how to set up internal links when content has been copied and pasted from Word as the internal links will not work. 
1. Go to the section in your document that features a hyperlink. In this example the words “product development type” are hyperlinked. 
[image: ]
2. Check to see where this hyperlink goes within the document. You may need to refer to the original Word document to identify the location. In this example clicking on the hyperlinked words “product development type” will take the user to “A2.3” in “Appendix 2: Determining product development type” (pictured below). 
[image: ]


3. Locate the hyperlink location in your HTML document. In this example, to locate Appendix 2 you would click Ctrl + F to perform a search. A search bar will appear at the top of the page, enter the phrase “Appendix 2” and click Next to be taken to that section. 
[image: ]
4. Select the text from this section you would like to link to. In this example, “Major and minor changes” has been selected. 
[image: ]


5. Go to the Insert tab and select Link and then From Address. 
[image: ]
6. The Insert Hyperlink pop-up box will appear. Leave the text in Text to display as is, but provide link of the page in the Address. 
[image: ]
This link will be the browser link at the top of the page.
[image: ]
7. Click Ok. 


8. At the top of the page, you will need to enter a name for the Bookmark. In this example, the name will be “Product Development”. You will also need change the colour of your hyperlink text from blue to black. 
[image: ]
[image: ]
9. Copy the bookmark by clicking Ctrl + C. 
10. Return to the original hyperlink you wanted to update. In this example it would be the “product development type” hyperlink. 
[image: ]
11. Click on this hyperlink. 
12. Go to the Link tab and mention the bookmark name in the URL. Ensure that the “Open in a new tab” checkbox has not been selected. 
[image: ]


13. Test to see in the link has been set up correctly by going to the Page tab and selecting Preview. Click Ok on the warning message that appears. 
[image: ]
14. Select Leave this page from the message that appears. 
[image: ]
15. A new tab will open in your Internet browser so that you can preview to see if the link you created works. In this example click on the words “product development type” goes to section A2.3 in Appendix 2. If your testing goes well, you can go back to the Document tab to Check In and Publish your document. 
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Introduction The increasing use of technology to communicate brings with it both
challenges and opportunities. Not only does technology allow a more
efficient means of sharing information and communicating with our
customer, there are also challenges due to the public nature, given the
immediate means that information can be disseminated.  Electronic
communications can also create opporutnities for unlawful conduct by
market paticipants.

Purpose This Policy is designed to provide staff with guidance regarding the use of
electronic communication mediums to ensure that

« Staff engage in appropriate communications when using various
mediums of technolo

« Al electronic communications will be recorded and retained for a
minimurm period of 7 years

This Policy supports the Group's Vision and Values, as set out in Our
Commitments. Our Commitments and our Values outline the expected
behavior consistent with full and proactive compliance with all of the
Group's policies. The Group’s core value of integrity means that you are
trustworthy and do the right thing. Compliance with this Policy forms part of
your commitment to understanding and fulfling all aspects of your role.

Below are examples how living our values in the specific context of this
policy could be demonstrated.

Integrity:
We must ensure we operate in financial markets in a fair and transparent
manner and avoid using technology to engage in inappropriate
communications which could amount to illegal practices or otherwise
damage the reputation of the Bank. Staff must only use technology to do
the right thing

Collaborati
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11.  Principle 8: Outsourcing and agents

Group entities must perform due diligence on all outsourcing providers and agents. Where these
entities are performing functions to satisfy the Group’s regulatory obligations, Group entities must
undertake appropriate assurance to ensure these obligations are being satisfactorily fulflled

12.  Principle 9: Reporting

Group entities must adhere to the reporting requirements of regulators and competent local
authorities in the jurisdictions in which they operate. This includes the reporting of suspicious matters
where required

13.  Principle 10: Record Keeping

Group entities must maintain all records necessary to evidence compliance with AMLICTF
obligations (including customer identification and transaction records) for a minimum period of at
least five years (or longer f required by local requirements)

1.4.  Principle 11: Independent Review

Group entities must ensure that reviews of compliance with the principles set out in this Policy are
undertaken in accordance with the Group’s Three Lines of Defence framework|
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« the approved Trading Books and Trading Book practices, as part of the Trading Book Policy Statement
« delegated authorites, the risk measurement methodology, imit structure and excess management

2. Scope of this Standard

This Standard applies to the APRA Level 2 entities with Trading Books that are covered by APS 116: Capital Adequacy, Market Risk. For
the Group this is Commonwealth Bank of Australia (CBA) and subsidiary Banks.

3. Definition of a Trading Book

Trading Books must be specifically approved (see Section A.2) and mest the Trading Principles (the Policy - Appendix D) and Trading
Book Practices (Appendix B).

4. At a glance

Appendices
Appendix A Approved Trading Books (as part of the Trading Book Policy
Statement)
Appendix B Trading Book Practices (as part of the Trading Book Policy
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+ “ADI" means an authorised deposit taking institution required to be licensed under the Sanking Act
+ “APRA” means the Australian Prudential Regulation Authority

+ *Bank’ means the Commonwealth Bank of Australia (ACN 123 123 124).
+ *Banking Act' means the Banking Act 1959 (Cth)

+ and Propriety Assessment’ means the assessment of an individual's fitness and propriety having regard to
the matters set out in Fit and Proper Procedural Requirements set out in Annexure C of this Policy.
+ Company and General

+ by APRA under section 29D of the SIS Act
+ *RSE Licensee’ means a company that holds a RSE Licence within the Wealth|
e
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1

The Responsible Person positions of each Regulated
Institution (including of a connected entity or subsidiary,
if determined in accordance with 4.1(b)) aref 1]

1. Positions held by
1. The Directors;

FSFSEN

6.

The Secretary of a RSE Licensee;

The Auditor;

The Appointed and Reviewing Actuary of a General
Insurance Company;

The Appointed Actuary of a Life Insurance Company or
RSE Licensee[2];

Senior Managers; and

2. Any position, nominated by the Chief Executive Officer or an
Executive General Manager (as applicable[2]) and approved
by the Board of the relevant Regulated Institution, involving
performance of activities for a subsidiary or connected entity
of the Regulated Institution, where those activities may
materially affect the whole, or a substantial part of the
Regulated Institution’s (or in the case of the Bank, the
Group’s) business, or financial standing, either directly or
indirectly.
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deemed employee

Deemed associate

products), including off-market dealings™*;

« applying for, acquiring or exercising options or performance rights over
securities;

« making an election to participate or cease participation in a dividend
reinvestment pian;

« acting as an executor or executrix for an estate which includes a parcel or
shares; or

« entering into an agreement to do any of the above things.

*This policy does not apply to an off-market transfer of securities when exclusively related
to the requirement of Business Unit staff needing trade approval. Staff are stil subject to
Insider Trading prohibitions and additional trading obiigations in accordance with the Group
Securities Trading Policy when conducting offmarket transfers

means a non-Business Unit staff member who primarily provides support services
toa stockbroking business.
means person(s) with whom an association may be inferred, even if no such

association actually exists. Examples include:

+ non-family members who share the same address (flatmates, girlfriend,
boyfriend):

« brothers, sisters, cousins, parents, in-laws (but not spouses, de factos,
dependants as they are captured above):
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Title of this document: Group Fit and Proper Policy

Owner of this document: Executive General Manager Compliance




image14.png
[ACCORDION-STOP]

FIT AND PROPER POLICY

Document control table





image15.png
Header 1 [Header 2

FIT AND PROPER POLICY

Document control table

Title of this document: Group Fit and Proper Policy





image16.png
Restrictions of:

Loss
+ Residual Value ovestments (RV):a directivestment inhe |
Ti
asset remaining at end of lease term 99
ers
*  Residual Value Guarantees (RVG): a contracted Put or Pu/Call
RV permitted financial a
depending on the initial lease structure regarding the asset value | A
instrument
atend of lease Stres
« Residual Value Insurance (RVI): an insurance policy to coverthea |
shortfall on the final sale value of the asset Testi
ng
Industrial Equipment Technology Equipment The
3 purp
1rgo ose
Individual transaction ROTE | Difference  between  expected | N/A for IT Equipment as transactions | ¢
(Quarterly) Retum On Target Equity (ROTE) at | are on a portfolio basis. the
inception and actual backtested | pegitncare Equipment has loss trigger | Loss
ROTE greater than 20% (refative 1o | for rigg
initial ROTE) o assettype concentration ers
Asset Class Variance between fair market value | o geography is to
(Annual) at time of disposal or fixed price | o largestclient ensu
purchase option established at | o maturity re
deal's inception and final sale price that
greater than 30% in
the
Stress Testing & Back Testing even
tof
Stress Testing Methodology | The  Stress  Testing  Matrix | Stressing and back-testing of factors
a
incorporates  three  types  of [ o inertia period N
loss
stresses o asset resale value i
om
o plausible o termination behaviour .
Tis
o implausible o pay-outratio -





image17.png
Document Content *

Fmancia| Anancial FINANCIAL cusTOMER seRvice & LEGAL/REGULATORY. MANAGEMENT
REPUTATION/ BRAND peoLE customers
usivess)| (rruster)s | rumrus)* opeRaTIONS compuance EFFORT GUIDANCE *¢
Rsessment | 45 per *mpse] + mpscton * Loss of existing « FallinGroup'sshare | * Regulstory Workpisceheslth| + Acwslor * Orainon Executive
Basedons | Groupor on Funds uncer custo price acten astery porentisl
fusness Urie Mansgement * losofnewbusiness /| * Customerfeira Workpiace impacton * Opportitycost
Price * costor market share. pary legal retstions customers
urie e
Aaministration remediaionrecoven incluesimpacts on actons 3
defined
ailbrands e moratefeyaity
Colonia, A58,
Sankwest
* Damage toreputation
by sctions ot both
indidul sefrznd
the Group s 3 whole
* Lack of confidencein fin ()~
financilsector
sereraly
5 |Asper | »100bp ~20% + Significantloss of| _+ Significant fall (= |+ Actual or Death or + serious « Potential to lead|
Severe |Group market share and| 20%) in Group's potentialloss| incapacitation financial o to the significant|
or customer share price oflicense, to employees reputational damage to the
numbers resulting from loss of ASX whilst on impactto business
Business
because of financial listing and/or| Group all or most « Sustained
Unit
extensive performance with penalties on business, or customers ExCo/Senior
defined interruption to recovery over directors customers on Management




image18.png
Attachment A

Approving Authority

Committee | CEO Relevant
GE

CEO
ASB

coowm

Criteria

PART A: All Non-Executive Director appointments

1. ToaGroup v
Subsidiary or
Group-related
Company, other
than an Investee
GAM Company
(see No.2)

Skills, experience and qualifications required to
carry out the duties and responsibilities of a
director of the relevant entity.

Meets all regulatory requirements, including
fitness and propriety and independence criteria
(if applicable).

No conflicts that cannot be managed.

Board diversity considered, including gender
diversity.

Demonstrated robust selection process.
Appointment recommended by the relevant GE,
unless the candidate is a Retiring/Retired
Employee in which case appointment is to be
recommended by the relevant BU/SU GE or, if
the employee is/was a GE, the CEO.

Meets with at least one member of the
Committee or any CBA director (or nominated
delegate). This criterion applies only to initial
term approvals, not term renewals.

Remuneration is within the fee structure set by
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PART A: Al Non-Executive Diractor appaintmnts

1. Toarouw v - Skills, experiance and qualfications required to
Subsidiary or carry out the duties and responsibiltes of 3
Group-related director ofthe ralevant enity.
x"ﬁ'::':’;:’:‘; * Meets all regulatory requirements, including.
oo company fitness and propristy and indspsndance critaris
(sseNo2)

+ No conflicts that cannot be managed.
+ Board diversity considered, including gander
diversity.
+ Demonstrated robust selection procass.
‘Appaintment recommended by the relevant GE,
unless the candidate is  Retiring/Retired.
Employea in which case appointment i 1o ba
recommended by the relevant BU/SU GE or, f
the employee is/was a GE, the CEO.
+ Masts with at least one mamber of the
Committee or any CBA director (or nominated
delogate). This criterion applies orly to intial
term approvals,not term reneuwals.

Remuneration is within the fes structure set by
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1. Toarouw v - Skills, experiance and qualfications required to
Subsidiary or carry out the duties and responsibiltes of 3
Group-related director ofthe ralevant enity.
x"ﬁ'::':’;:’:‘; * Meets all regulatory requirements, including.
oo company fitness and propristy and indspsndance critaris
(sseNo2)

+ No conflicts that cannot be managed.

+ Board diversity considered, including gander
diversity.

+ Demonstrated robust selection procass.

‘Appaintment recommended by the relevant GE,

unless the candidate is  Retiring/Retired.

g Employea in which case appointment i 1o ba
recommended by the relevant BU/SU GE or, f
the employee is/was a GE, the CEO.

+ Masts with at least one mamber of the
Committee or any CBA director (or nominated
delogate). This criterion applies orly to intial

term spprovals, not term reneuils.
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PART A: All Non-Executive Director appointments
1. ToaGroup v + Skills, experience and qualifications required to
Subsidiary or carry out the duties and responsibilities of a
Group-related director of the relevant entity.

Company, other
than an Investee

GAM Company ' :
(see No.2) (if applicable).

No conflicts that cannot be managed.

Meets all regulatory requirements, including
fitness and propriety and independence criteria

Board diversity considered, including gender

diversity.

Demonstrated robust selection process.

Appointment recommended by the relevant GE,
unless the candidate is a Retiring/Retired

a Employee in which case appointment is to be
recommended by the relevant BU/SU GE or, if
the employee is/was a GE, the CEO.

Meets with at least one member of the
Committee or any CBA director (or nominated
delegate). This criterion applies only to initial

term approvals, not term renewals.

Remuneration is within the fee structure set by
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Group-related
Company, other
than an Investee
GAM Company
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Skills, experience and qualifications required
to carry out the duties and responsibilities of
a director of the relevant entity.

Meets all regulatory requirements, including
fitness and propriety and independence
criteria (if applicable).

No conflicts that cannot be managed.

Board diversity considered, including gender
diversity.

Demonstrated robust selection process.
Appointment recommended by the relevant
GE, unless the candidate is a Retiring/Retired
Employee in which case appointment is to
be recommended by the relevant BU/SU GE
or, if the employee is/was a GE, the CEO.
Meets with at least one member of the
Committee or any CBA director (or
nominated delegate). This criterion applies
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34 "Trustee” means the company holding the RSE Licence.
1. Interpretation

(a)  Inthis Policy, unless the context otherwise requires, words importing one gender shall import all genders, words importing the

singular shall import the plural and words importing the plural shall import the singular

(b)
satisfactory completion of required checks and documentation as outiined in Annexure C of this Policy.

Under this Policy, a person shall not be considered to have been permanently appointed to a Responsible Person position until

2 INTRODUCTION
1. The Prudential Standard CPS520 covering ADIs, Life Insurance Companies and General Insurance Companies applies to:

1. the Bank a5 an ADI;
2. The Colonial Mutual Life Assurance Society Limited (CMLA) 25 a Life Insurance Company; and
3. Commonwealth Insurance Limited (CIL) 35 a General Insurance Company.

1. The Bank must comly with this Policy:

1 inits capacity 35 a Regulated Institution; and
2.inits capacity as the head of the Group, by ensuring that Responsible Persons are approved in accordance with section 4.1(b) of this Policy,
where an entity within the Group is not a Regulated Institution and that entity engages in business activities that may materially affect, either
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that the person is familiar with current issues in the audit of that type of Regulated Institution
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The Commonwealth Bank of Australia Designated Business Group (CBA DBG) Joint Anti-Money
Laundering and Counter-Terrorism Financing (AML/CTF) Program has (the Program) been prepared
for the purposes of enabling members of the CBA DBG to comply with obligations under the Ant/-
Money Laundering and Counter-Terrorism Financing Act 2006 (the Act) and the Anti-Money Laundering
and Counter-Terrorism Financing Rules (the Rules).The Program is comprised of two Parts: Part A and
Part B.

The Group’s Board has approved Part A of the Program. Each reporting entity which is a member of the
CBA DBG must adopt and maintain the Program.

The primary purpose of Part A is to identify, mitigate and manage the risk that each member of the CBA
DBG may reasonably face that the provision of designated services at or through its Australian
operations might (whether inadvertently or otherwise) involve or facilitate money laundering or financing
of terrorism.

Part A is also designed to:

- ensure that any member of the CBA DBG that provides designated services at or through a
permanent establishment outside of Australia takes the action specified in the Rules in relation to
the provision by that member of designated services at or through that permanent establishment

- enable the Group to understand the nature and purpose of the business relationship with the
Group’s customer types and understand the control structure of non-individuals.

Part B documents the Program requirements in relation to Customer Identification & Verification. Part B
does not require Board approval and is approved by the Group AML/CTF Compliance Officer.

1.1."—Documents Comprising the Program|

The Program is comprised of this document and Part B of the Program. The Program must also be read
in conjunction with relevant AML/CTF Group Standards. These standards are available on the Group
Financial Crime Services (Group FCS) intranet page.
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The Commonwealth Bank of Australia Designated Business Group (CBA DBG) Joint Anti-Money
Laundering and Counter-Terrorism Financing (AML/CTF) Program has (the Program) been prepared
for the purposes of enabling members of the CBA DBG to comply with obligations under the Ant/-
Money Laundering and Counter-Terrorism Financing Act 2006 (the Act) and the Anti-Money Laundering
and Counter-Terrorism Financing Rules (the Rules).The Program is comprised of two Parts: Part A and

Part B.
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the provision by that member of designated services at or through that permanent establishment |
- enable the Group to understand the nature and purpose of the business relationship with the
Group’s customer types and understand the control structure of non-individuals.

Part B documents the Program requirements in relation to Customer Identification & Verification. Part B
does not require Board approval and is approved by the Group AML/CTF Compliance Officer.
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Appendix 2: Determining product development type

A2.1. The level of stakeholder engagement and approval required will vary dependent up
the type of product development being undertaken and the extent of the change.

A2.2. The following criteria must be used to determine what is considered a major chanc
All other changes are considered to be minor changes.

A23.

New target market

An existing product is being offered to a new target market or customer segment (e.g.
from wholesale to retail).

New product (including new product class or line)

As defined in pre regist
products that are not expected to significantly impact the business’ customer base now
or in the future.

Product Upgrade

Replace an existing product with an updated version that offers material changes to
features and benefits which is expected to significantly impact the business’ customer
base now or in the future.

New bundle

Existing products are being combined for the first time or in a different way e.g. bundling
lending, savings, investment and/or insurance products in a different package.

Product closure

A product is being withdrawn, temporarily suspended, quarantined or retired.
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customers' financial wellbeing.

1.2 Use this policy to:
- develop new products and services or make changes to existing products and services (including closure);

- ensure products and sehices are developed and distributed to meet target market and customer needs and

interests;
- ensure development of products and services is subject to appropriate governance, with comprehensive

review and challenge by relevant stakeholders before launch; and
- be clear about ongoing product and service monitoring and review requirements throughout the life of

products and services.

2. Roles and Responsibilities

Key roles which have accountabilities and responsibilities in relation to product development and distribution

2.1,
are defined below and in the RACI.
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Appendix 2: Determining product development type

A2.1. The level of stakeholder engagement and approval required will vary dependent upon the type of product

development being undertaken and the extent of the change.

A2.2. The following criteria must be used to determine what is considered a major change. All other changes
are considered to be minor changes.

A2.3.  JETeEhEiplhtadiehesimust adhere to defined approval levels.

New target market

An existing product is being offered fo a new target market or customer segment (e.g. from
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Appendix 2: Determining product development type

A2.1. The level of stakeholder engagement and approval required will vary dependent upon the type of product
development being undertaken and the extent of the change.

A2.2. The following criteria must be used to determine what is considered a major change. All other changes
are considered to be minor changes.

A2.3. Major and minor changes must adhere to defined approval levels.

New target market





image57.png
BROWSE ~ PAGE  PUBLISH | FORMAT TEXT | INSERT |

= o [ é&’ﬁ QFD; a?m <[>

Table  Picture Videoand Lk Upload Reusable ~ App Web  Embed
- - Audio - File Content Part Part Code

Tables Media Links Content Parts Embed
| | | . FProauct xeviews

Appendix 2: ermining prod

t development type|

A2.1. The level of stakeholder engagement and approval required will vary dependent upon the type of product

development being undertaken and the extent of the ¢ -

A2.2. The following criteria must be used to determine wh .
Insert Hyperlink
are considered to be minor changes.

A2.3. Major and minor changes must adhere to defined apy  Text to display:
Major and minor changes

Address:
IDevelopment%20and%20Distribution%20Policy.as X
Try link
New target market
An existing product is being offered to a new target market or cus oK Cancel

wholesale fo retail).

New product (including new product class or line)
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A2.2. The following criteria must be used to determine what is considered a major change. All other changes
are considered to be minor changes.

A2.3. Major and minor changes must adhere to defined approval levels.

New target market

An existing product is being offered fo a new target market or customer segment (e.g. from
wholesale fo retal).

New product (including new product class or line)

As defined in product register minimum requirements. Excludes variations to existing products

that are not expected fo significantly impact the business’ customer base now or in the future.

Product Upgrade

Replace an existing product with an updated version that offers material changes to features and
benefits which is expected fo significantly impact the business’ customer base now or in the
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6. Governing product development through the lifecycle

At each stage of the product development and distribution lifecycle the Product Owner is responsible for the

governance of key activities, artefacts and approvals. It may be appropriate to agree a more streamlined process
with Line 2 BU Risk dependant on the extent of the change and the delivery approach e.g. waterfall, agile.

6.1. Concept

c Final roval and Ongoing Distribution

Activities

To formalise an idea the product
concept must be developed to clearly
articulate the ownership and the
product development type; value to
customers; distribution arrangements;
value to the business; high level
processes, systems, risks and
controls; legal, regulatory and
competitive environment.

facts

Product Register

Product Concept Paper (or equivalent)

Approvals

Reference must be made to the
product register to assist in
determining the

product development type and to
establish the approval authorities
required.
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where necessary, any remediation action.

5.19. When the outcome of a product review is to close the product the reason must be understood and clearly
documented. The impact on customer financial wellbeing must be considered, ensuring needs and
interests are met. All obligations to customers in relation to the product to be closed must be met.

At each stage of the product development and distributio

governance of key activities, artefacts and approvals. It To save your changes before continuing, click "OK". To continue
with Line 2 BU Risk dependant on the extent of the chang without saving changes, click "Cancel".

6.1. Concept

Activities Artefacts Approvals

To formalise an idea the product Reference must be made to the
product register to assist in
determining the

product development type and to

establish the approval authorities

Product Register

concept must be developed to clearly

Product Concept Paper (or equivalent)
articulate the ownership and the

product development type; value to
customers; distribution arrangements;
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1. Overview & Purpose

11 As the holder of an Australian Financial Services Licence (“AFSL”) and
internationallicenses, we are obliged to ensure that the financial services
covered by our licence are provided efficiently, honestly and fairly. To help meet
this obligation, this Policy establishes um requirements and standards for
how Business Units record, maintain, store and retrieve all relevant records.

12 This Policy supports the Group’s Vision and Values, as set out in Our
Commitments. Our Commitments and our Values outline the expected
behaviour consistent with full and proactive compliance with all of the Group’s
policies. Compliance with this Policy forms part of your commitment to
understanding and fulflling all aspects of your role.

13 Below are some examples to illustrate how living our values in the specific
context of this Policy could be demonstrated,

Integrity:
Having an effective record keeping system enables transparent, reliable and
accurate records of our business activities and clients.

Collaboration:

Make sure the relevant stakeholders are involved when changing systems which
may store records and appropriate signoff is obtained by legal, compliance and
others. Raise questions if you suspect our records or record keeping systems are
not reliable and robust.

Accountability:

By reading and adhering to this Policy you are ensuring you understand what
records are to be retained, how to maintain records and for how long. You are




